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Using the Pattern Filter Tool

Use the Pattern Filter tool to filter a data stream before you view it or 
store it to a file. You can specify which states in the data you want to 
pass through the filter, or which states you want to filter out. 

• “Filtering States Out of the Data” on page 6

• “Passing Only Desired States Through the Filter” on page 7

• “Passing All States Through the Filter” on page 8

• “Loading & Saving Filter Configurations” on page 17

• “Printing the Pattern Filter Window” on page 18 

See Also “Working With Filter Terms” on page 9

Main System Help (see the Agilent Technologies 16700A/B-Series Logic 

Analysis System help volume)

Glossary of Terms (see page 19) 
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Chapter 1: Using the Pattern Filter Tool
Filtering States Out of the Data
Filtering States Out of the Data

1. Select Remove Matching Data.

2. In the Filter Terms area, define a filter term (see page 10) to match the 
condition that you want to filter on. 
All of the labels in a filter term are logically AND'ed together.

3. If necessary, add more terms (see page 9) to the expression. 
At the top of the Pattern Filter window is a filter expression that shows 
each of the terms that are logically OR'ed together.

4. Select the Run icon to acquire and filter data, or if data has already been 
acquired, select Apply to filter it. 

All states in the data that match the filter expression are filtered out of 
the data.

Example This setup filters out states that contain a READ from a particular 
range of memory addresses. This condition is indicated by a value of 1 
for label R/*W and a memory address in the range 3400-35FF hex. The 
filter term READ_HI is defined to match this condition.
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Chapter 1: Using the Pattern Filter Tool
Passing Only Desired States Through the Filter
Passing Only Desired States Through the Filter

1. Select Pass Matching Data.

2. In the Filter Terms area, define a filter term (see page 10) to match the 
condition you want to filter on. 
All of the labels in a filter term are logically AND'ed together.

3. If necessary, add more terms (see page 9) to the expression. 
At the top of the Pattern Filter window is a filter expression that shows 
each of the terms that are logically OR'ed together.

4. Select the Run icon to acquire and filter data, or if data has already been 
acquired, Select Apply to filter it. 

Only those states in the data stream that match the filter expression 
are passed through. The rest are filtered out.

Example This setup passes through only those states that contain a READ from 
one of two memory address ranges, 3400-35FF hex, or 1000-100F hex. 
A READ is indicated as pattern 1 on label R/*W. The filter term 
READ_HI is set up to match a read from one of the address ranges. The 
filter term IO_READ is set up to match a read from the other.
7



Chapter 1: Using the Pattern Filter Tool
Passing All States Through the Filter
Passing All States Through the Filter

1. Select Pass All Data.

2. Select Run to acquire and filter data, or if data has already been acquired, 
select Apply to filter it. 

You can also turn off some or all of the terms (see page 15) in order to 
pass all of the data.
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Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
Working With Filter Terms

Filter terms are used to define a filter expression that determines how 
data is filtered. The filter terms are logically OR'ed together to create 
the filter expression, which is shown at the top of the Pattern Filter 
window. 

Each filter term is made up of data patterns and ranges for one or more 
labels. All of the labels associated with a particular filter term are 
logically AND'ed together to create the filter term. 

• “Adding and Deleting Filter Terms” on page 9

• “Defining and Changing Filter Term Values” on page 10

• “Adding Labels to a Filter Term” on page 11

• “Deleting Labels from a Filter Term” on page 12

• “Replacing Labels in a Filter Term” on page 13

• “Changing Term Names” on page 14

• “Turning Filter Terms On and Off” on page 15

• “Creating Powerful Filter Expressions” on page 15 

Adding and Deleting Filter Terms

To Add a Filter Term:

1. Select one of the terms in the Filter Terms area.

2. Select Insert term before or Insert term after. 

To Delete a Filter Term:

1. Select the term that you want to delete.

2. Select Delete term. 
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Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
To Delete All Terms:

1. Select any of the terms in the Filter Terms area. 

2. Select Delete all terms. 
One term will remain. The pattern for this term will be all Don't Cares, 
represented by X's. 

See Also “Defining and Changing Filter Term Values” on page 10

“Adding Labels to a Filter Term” on page 11

“Deleting Labels from a Filter Term” on page 12 

Defining and Changing Filter Term Values

The value of a filter term consists of the logical AND of each of the label 
patterns or ranges associated with the term. To change the value of the 
filter term: 

1. If desired, change the term name (see page 14).

2. Add the desired labels (see page 11) to the term.

3. For each label, set the numeric base.

4. Select a pattern or range mode (see page 11). 

5. Type the pattern or range value. 

See Also “Adding and Deleting Filter Terms” on page 9

“Adding Labels to a Filter Term” on page 11

“Deleting Labels from a Filter Term” on page 12 
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Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
Pattern and Range Modes

Four modes are available for each label assigned to a filter term: 
Pattern, Range, Not Pattern and Not Range. 

Not Pattern selects all patterns except the defined pattern. For 
example, if the defined pattern is 11 binary and the mode is set to Not 

Pattern, this is the same as defining three filter terms: one for 00, one 
for 01, and one for 10, and setting them all to Pattern. (Filter terms 
are ORed together.) 

Not Range selects the values outside the range you define. If the range 
for a four-bit label is 0 through 8 hex, and the mode is set to Not 

Range, this is the same as setting the mode to Range and range value 
as 9 through F hex.

Adding Labels to a Filter Term

1. Select one of the labels that is already assigned to the term. 
If no labels are present, make sure that the filter is connected to an 
instrument tool, and that there are labels defined in the instrument tool 
windows. 

2. Select Insert label.

3. In the Label Selection dialog, select the label name to be inserted. 
To select multiple labels, highlight the desired labels.

4. Select Apply. 

5. Select Close to close the Label Selection dialog. 
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Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
See Also “Adding and Deleting Filter Terms” on page 9

“Deleting Labels from a Filter Term” on page 12 

Deleting Labels from a Filter Term

1. Choose the label name you want to delete.

2. Select Delete label. 
The Filter Terms dialog will show your deleted label gone.

3. To delete all of the labels from a term, select Delete all labels. 
At least one label name will remain, with a pattern of all Don't Cares, 
represented by X's. 
12



Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
See Also “Adding and Deleting Filter Terms” on page 9

“Adding Labels to a Filter Term” on page 11 

Replacing Labels in a Filter Term

1. Choose the label name you want to replace.

2. Select Replace label.

3. In the Label Selection dialog, select the name of the replacement label.

4. Select Apply. 

5. Select Close to close the Label Selection dialog 
Your replacement label will have default values, which you can change. 
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Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
See Also “Adding and Deleting Filter Terms” on page 9

“Adding Labels to a Filter Term” on page 11

“Deleting Labels from a Filter Term” on page 12 

Changing Term Names

1. Choose the term whose name you want to change.

2. Select Rename term.

3. In the Rename Term dialog, enter in the new name.

4. Select OK. 

See Also “Adding and Deleting Filter Terms” on page 9 
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Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
Turning Filter Terms On and Off 

You can remove a filter term from the filter expression by turning it off. 
This will preserve the term definition, but will remove the term from 
the set of OR'ed terms that are used to filter the data. 

1. Select the term you want to turn on or off.

2. Select Term [ON]/[OFF] to toggle the control. 
Terms that are turned off do not appear in the filter expression at the top 
of the Filter Terms window. 

NOTE: Terms that are off are grayed-out. None of the labels or values can be changed 
until the term is turned on again.

See Also “Adding and Deleting Filter Terms” on page 9

“Adding Labels to a Filter Term” on page 11

“Deleting Labels from a Filter Term” on page 12 

Creating Powerful Filter Expressions 

The default filter expression ORs all filter terms together. You can 
override the default to create more complex combinations of filter 
terms when you need powerful filter expressions. 

NOTE: Expression filtering is not available and will be greyed out when Timing Zoom 
is turned on. In order for expression filtering to work properly, you MUST turn 
Timing Zoom off and configure the Pattern Filter tool to a single data set 
input.

1. In the menu bar, select Options, then set Expression to On. 
The Filter Terms field becomes a text entry field. See the Note above.

2. Create any desired expression composed of the defined filter terms.

3. Available operators are: 

*=AND 
15



Chapter 1: Using the Pattern Filter Tool
Working With Filter Terms
+=OR

()=grouping filter terms 

Example:
16



Chapter 1: Using the Pattern Filter Tool
Loading & Saving Filter Configurations
Loading & Saving Filter Configurations

Pattern Filter settings can be saved to a configuration file on hard disk 
or floppy disk, and settings can be loaded from previously saved 
configuration files.

• Loading Configuration Files (see the Agilent Technologies 16700A/B-

Series Logic Analysis System help volume)

• Saving Configuration Files (see the Agilent Technologies 16700A/B-

Series Logic Analysis System help volume) 

NOTE: The Load Configuration window can be accessed via File->Load 
Configuration. 
The Save Configuration window can be accessed via File->Save 
Configuration.
17



Chapter 1: Using the Pattern Filter Tool
Printing the Pattern Filter Window
Printing the Pattern Filter Window

The print windows operation enables you to print just the Pattern 
Filter tool window. Use this operation if you want a hardcopy or 
electronic record of configurations and data currently displayed in the 
viewing area of the Pattern Filter window.

NOTE: Only the currently displayed viewing area of the Pattern Filter window is 
printed. If any data or configuration fields appear offscreen, scroll the desired 
data or configuration fields into the window's viewing area before printing.

1. Optional - configure the Print Options (see the Agilent Technologies 

16700A/B-Series Logic Analysis System help volume) if desired. 
Print Options include print destination, file format type, filename 
autoincrement, and color/b&w; pixel mapping. 

2. In the Pattern Filter tool menu bar, select File, then select Print This 

Window. The print output will be as configured in the Print Options in 
step 1. 

See Also Setup the Printer (see the Agilent Technologies 16700A/B-Series Logic 

Analysis System help volume) 
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Glossary
absolute  Denotes the time period 
or count of states between a captured 
state and the trigger state. An 
absolute count of -10 indicates the 
state was captured ten states before 
the trigger state was captured.

acquisition  Denotes one complete 
cycle of data gathering by a 
measurement module. For example, 
if you are using an analyzer with 
128K memory depth, one complete 
acquisition will capture and store 
128K states in acquisition memory.

analysis probe  A probe connected 
to a microprocessor or standard bus 
in the device under test. An analysis 
probe provides an interface between 
the signals of the microprocessor or 
standard bus and the inputs of the 
logic analyzer. Also called a 
preprocessor.

analyzer 1  In a logic analyzer with 
two machines, refers to the machine 
that is on by default. The default 
name is Analyzer<N>, where N is 
the slot letter.

analyzer 2  In a logic analyzer with 
two machines, refers to the machine 
that is off by default. The default 
name is Analyzer<N2>, where N is 
the slot letter.

arming  An instrument tool must be 
 

armed before it can search for its 
trigger condition. Typically, 
instruments are armed immediately 
when Run or Group Run is selected. 
You can set up one instrument to arm 
another using the Intermodule 

Window. In these setups, the second 
instrument cannot search for its 
trigger condition until it receives the 
arming signal from the first 
instrument. In some analyzer 
instruments, you can set up one 
analyzer machine to arm the other 
analyzer machine in the Trigger 

Window. 

asterisk (*)  See edge terms, 
glitch, and labels.

bits  Bits represent the physical logic 
analyzer channels. A bit is a channel 
that has or can be assigned to a label. 
A bit is also a position in a label.

card  This refers to a single 
instrument intended for use in the 
Agilent Technologies 16700A/B-
series mainframes. One card fills one 
slot in the mainframe. A module may 
comprise a single card or multiple 
cards cabled together.

channel  The entire signal path from 
the probe tip, through the cable and 
module, up to the label grouping. 

click  When using a mouse as the 
19



Glossary
pointing device, to click an item, 
position the cursor over the item. 
Then quickly press and release the 
left mouse button.

clock channel  A logic analyzer 
channel that can be used to carry the 
clock signal. When it is not needed 
for clock signals, it can be used as a 
data channel, except in the Agilent 
Technologies 16517A.

context record  A context record is 
a small segment of analyzer memory 
that stores an event of interest along 
with the states that immediately 
preceded it and the states that 
immediately followed it.

context store  If your analyzer can 
perform context store 
measurements, you will see a button 
labeled Context Store under the 
Trigger tab. Typical context store 
measurements are used to capture 
writes to a variable or calls to a 
subroutine, along with the activity 
preceding and following the events. A 
context store measurement divides 
analyzer memory into a series of 
context records. If you have a 64K 
analyzer memory and select a 16-
state context, the analyzer memory is 
divided into 4K 16-state context 
records. If you have a 64K analyzer 
memory and select a 64-state 
context, the analyzer memory will be 
20
divided into 1K 64-state records.

count  The count function records 
periods of time or numbers of state 
transactions between states stored in 
memory. You can set up the analyzer 
count function to count occurrences 
of a selected event during the trace, 
such as counting how many times a 
variable is read between each of the 
writes to the variable. The analyzer 
can also be set up to count elapsed 
time, such as counting the time spent 
executing within a particular function 
during a run of your target program.

cross triggering  Using intermodule 
capabilities to have measurement 
modules trigger each other. For 
example, you can have an external 
instrument arm a logic analyzer, 
which subsequently triggers an 
oscilloscope when it finds the trigger 
state.

data channel  A channel that 
carries data. Data channels cannot be 
used to clock logic analyzers.

data field  A data field in the pattern 
generator is the data value associated 
with a single label within a particular 
data vector.

data set  A data set is made up of all 
labels and data stored in memory of 
any single analyzer machine or 
  



Glossary
instrument tool. Multiple data sets 
can be displayed together when 
sourced into a single display tool. The 
Filter tool is used to pass on partial 
data sets to analysis or display tools.

debug mode  See monitor.

delay  The delay function sets the 
horizontal position of the waveform 
on the screen for the oscilloscope and 
timing analyzer. Delay time is 
measured from the trigger point in 
seconds or states.

demo mode  An emulation control 
session which is not connected to a 
real target system. All windows can 
be viewed, but the data displayed is 
simulated. To start demo mode, 
select Start User Session from the 
Emulation Control Interface and 
enter the demo name in the 
Processor Probe LAN Name field. 
Select the Help button in the Start 

User Session window for details.

deskewing  To cancel or nullify the 
effects of differences between two 
different internal delay paths for a 
signal. Deskewing is normally done 
by routing a single test signal to the 
inputs of two different modules, then 
adjusting the Intermodule Skew so 
that both modules recognize the 
signal at the same time.
 

device under test  The system 
under test, which contains the 
circuitry you are probing. Also known 
as a target system.

don't care  For terms, a "don't care" 
means that the state of the signal 
(high or low) is not relevant to the 
measurement. The analyzer ignores 
the state of this signal when 
determining whether a match occurs 
on an input label. "Don't care" signals 
are still sampled and their values can 
be displayed with the rest of the data. 
Don't cares are represented by the X 
character in numeric values and the 
dot (.) in timing edge specifications.

dot (.)  See edge terms, glitch, 
labels, and don't care.

double-click  When using a mouse 
as the pointing device, to double-click 
an item, position the cursor over the 
item, and then quickly press and 
release the left mouse button twice.

drag and drop  Using a Mouse:
Position the cursor over the item, and 
then press and hold the left mouse 

button. While holding the left mouse 
button down, move the mouse to 
drag the item to a new location. When 
the item is positioned where you 
want it, release the mouse button.
21



Glossary
Using the Touchscreen:
Position your finger over the item, 
then press and hold finger to the 
screen. While holding the finger 
down, slide the finger along the 
screen dragging the item to a new 
location. When the item is positioned 
where you want it, release your 
finger.

edge mode  In an oscilloscope, this 
is the trigger mode that causes a 
trigger based on a single channel 
edge, either rising or falling.

edge terms  Logic analyzer trigger 
resources that allow detection of 
transitions on a signal. An edge term 
can be set to detect a rising edge, 
falling edge, or either edge. Some 
logic analyzers can also detect no 
edge or a glitch on an input signal. 
Edges are specified by selecting 
arrows. The dot (.) ignores the bit. 
The asterisk (*) specifies a glitch on 
the bit. 

emulation module  A module 
within the logic analysis system 
mainframe that provides an 
emulation connection to the debug 
port of a microprocessor. An E5901A 
emulation module is used with a 
target interface module (TIM) or an 
analysis probe. An E5901B emulation 
module is used with an E5900A 
emulation probe.
22
emulation probe  The stand-alone 
equivalent of an emulation module. 
Most of the tasks which can be 
performed using an emulation 
module can also be performed using 
an emulation probe connected to 
your logic analysis system via a LAN.

emulator  An emulation module or 
an emulation probe.

Ethernet address  See link-level 

address.

events  Events are the things you 
are looking for in your target system. 
In the logic analyzer interface, they 
take a single line. Examples of events 
are Label1 = XX and Timer 1 > 400 

ns.

filter expression  The filter 
expression is the logical OR 
combination of all of the filter terms. 
States in your data that match the 
filter expression can be filtered out or 
passed through the Pattern Filter. 

filter term  A variable that you 
define in order to specify which 
states to filter out or pass through. 
Filter terms are logically OR'ed 
together to create the filter 
expression. 

Format  The selections under the 
logic analyzer Format tab tell the 
  



Glossary
logic analyzer what data you want to 
collect, such as which channels 
represent buses (labels) and what 
logic threshold your signals use.

frame  The Agilent Technologies or 
16700A/B-series logic analysis system 
mainframe. See also logic analysis 

system.

gateway address  An IP address 
entered in integer dot notation. The 
default gateway address is 0.0.0.0, 
which allows all connections on the 
local network or subnet. If 
connections are to be made across 
networks or subnets, this address 
must be set to the address of the 
gateway machine.

glitch  A glitch occurs when two or 
more transitions cross the logic 
threshold between consecutive 
timing analyzer samples. You can 
specify glitch detection by choosing 
the asterisk (*) for edge terms under 
the timing analyzer Trigger tab.

grouped event  A grouped event is 
a list of events that you have 
grouped, and optionally named. It can 
be reused in other trigger sequence 
levels. Only available in Agilent 
Technologies 16715A or higher logic 
analyzers.

held value  A value that is held until 
 

the next sample. A held value can 
exist in multiple data sets.

immediate mode  In an 
oscilloscope, the trigger mode that 
does not require a specific trigger 
condition such as an edge or a 
pattern. Use immediate mode when 
the oscilloscope is armed by another 
instrument.

interconnect cable  Short name for 
module/probe interconnect cable.

intermodule bus  The intermodule 
bus (IMB) is a bus in the frame that 
allows the measurement modules to 
communicate with each other. Using 
the IMB, you can set up one 
instrument to arm another. Data 
acquired by instruments using the 
IMB is time-correlated.

intermodule  Intermodule is a term 
used when multiple instrument tools 
are connected together for the 
purpose of one instrument arming 
another. In such a configuration, an 
arming tree is developed and the 
group run function is designated to 
start all instrument tools. Multiple 
instrument configurations are done in 
the Intermodule window.

internet address  Also called 
Internet Protocol address or IP 
address. A 32-bit network address. It 
23



Glossary
is usually represented as decimal 
numbers separated by periods; for 
example, 192.35.12.6. Ask your LAN 
administrator if you need an internet 
address.

labels  Labels are used to group and 
identify logic analyzer channels. A 
label consists of a name and an 
associated bit or group of bits. Labels 
are created in the Format tab. 

line numbers  A line number (Line 
#s) is a special use of symbols. Line 
numbers represent lines in your 
source file, typically lines that have 
no unique symbols defined to 
represent them. 

link-level address  Also referred to 
as the Ethernet address, this is the 
unique address of the LAN interface. 
This value is set at the factory and 
cannot be changed. The link-level 
address of a particular piece of 
equipment is often printed on a label 
above the LAN connector. An 
example of a link-level address in 
hexadecimal: 0800090012AB.

local session  A local session is 
when you run the logic analysis 
system using the local display 
connected to the product hardware. 

logic analysis system  The Agilent 
Technologies 16700A/B-series 
24
mainframes, and all tools designed to 
work with it. Usually used to mean 
the specific system and tools you are 
working with right now.

machine  Some logic analyzers allow 
you to set up two measurements at 
the same time. Each measurement is 
handled by a different machine. This 
is represented in the Workspace 
window by two icons, differentiated 
by a 1 and a 2 in the upper right-hand 
corner of the icon. Logic analyzer 
resources such as pods and trigger 
terms cannot be shared by the 
machines.

markers  Markers are the green and 
yellow lines in the display that are 
labeled x, o, G1, and G2. Use them to 
measure time intervals or sample 
intervals. Markers are assigned to 
patterns in order to find patterns or 
track sequences of states in the data. 
The x and o markers are local to the 
immediate display, while G1 and G2 
are global between time correlated 
displays.

master card  In a module, the 
master card controls the data 
acquisition or output. The logic 
analysis system references the 
module by the slot in which the 
master card is plugged. For example, 
a 5-card Agilent Technologies 16555D 
would be referred to as Slot C: 
  



Glossary
machine because the master card is 
in slot C of the mainframe. The other 
cards of the module are called 
expansion cards.

menu bar  The menu bar is located 
at the top of all windows. Use it to 
select File operations, tool or system 
Options, and tool or system level 
Help.

message bar  The message bar 
displays mouse button functions for 
the window area or field directly 
beneath the mouse cursor. Use the 
mouse and message bar together to 
prompt yourself to functions and 
shortcuts.

module/probe interconnect cable  

The module/probe interconnect cable 
connects an E5901B emulation 
module to an E5900B emulation 
probe. It provides power and a serial 
connection. A LAN connection is also 
required to use the emulation probe.

module  An instrument that uses a 
single timebase in its operation. 
Modules can have from one to five 
cards functioning as a single 
instrument. When a module has more 
than one card, system window will 
show the instrument icon in the slot 
of the master card.
 

monitor  When using the Emulation 
Control Interface, running the 
monitor means the processor is in 
debug mode (that is, executing the 
debug exception) instead of 
executing the user program.

panning  The action of moving the 
waveform along the timebase by 
varying the delay value in the Delay 
field. This action allows you to 
control the portion of acquisition 
memory that will be displayed on the 
screen. 

pattern mode  In an oscilloscope, 
the trigger mode that allows you to 
set the oscilloscope to trigger on a 
specified combination of input signal 
levels.

pattern terms  Logic analyzer 
resources that represent single states 
to be found on labeled sets of bits; for 
example, an address on the address 
bus or a status on the status lines. 

period (.)  See edge terms, glitch, 
labels, and don't care.

pod pair  A group of two pods 
containing 16 channels each, used to 
physically connect data and clock 
signals from the unit under test to the 
analyzer. Pods are assigned by pairs 
in the analyzer interface. The number 
of pod pairs available is determined 
25



Glossary
by the channel width of the 
instrument.

pod  See pod pair

point  To point to an item, move the 
mouse cursor over the item, or 
position your finger over the item.

preprocessor  See analysis probe.

primary branch  The primary 
branch is indicated in the Trigger 

sequence step dialog box as either 
the Then find or Trigger on 
selection. The destination of the 
primary branch is always the next 
state in the sequence, except for the 
Agilent Technologies 16517A. The 
primary branch has an optional 
occurrence count field that can be 
used to count a number of 
occurrences of the branch condition. 
See also secondary branch.

probe  A device to connect the 
various instruments of the logic 
analysis system to the target system. 
There are many types of probes and 
the one you should use depends on 
the instrument and your data 
requirements. As a verb, "to probe" 
means to attach a probe to the target 
system.

processor probe  See emulation 

probe.
26
range terms  Logic analyzer 
resources that represent ranges of 
values to be found on labeled sets of 
bits. For example, range terms could 
identify a range of addresses to be 
found on the address bus or a range 
of data values to be found on the data 
bus. In the trigger sequence, range 
terms are considered to be true when 
any value within the range occurs.

relative  Denotes time period or 
count of states between the current 
state and the previous state. 

remote display  A remote display is 
a display other than the one 
connected to the product hardware. 
Remote displays must be identified to 
the network through an address 
location.

remote session  A remote session is 
when you run the logic analyzer using 
a display that is located away from 
the product hardware. 

right-click  When using a mouse for 
a pointing device, to right-click an 
item, position the cursor over the 
item, and then quickly press and 
release the right mouse button.

sample  A data sample is a portion of 
a data set, sometimes just one point. 
When an instrument samples the 
target system, it is taking a single 
  



Glossary
measurement as part of its data 
acquisition cycle.

Sampling  Use the selections under 
the logic analyzer Sampling tab to tell 
the logic analyzer how you want to 
make measurements, such as State 
vs. Timing.

secondary branch  The secondary 
branch is indicated in the Trigger 

sequence step dialog box as the Else 

on selection. The destination of the 
secondary branch can be specified as 
any other active sequence state. See 
also primary branch.

session  A session begins when you 
start a local session or remote 

session from the session manager, 
and ends when you select Exit from 
the main window. Exiting a session 
returns all tools to their initial 
configurations.

skew  Skew is the difference in 
channel delays between 
measurement channels. Typically, 
skew between modules is caused by 
differences in designs of 
measurement channels, and 
differences in characteristics of the 
electronic components within those 
channels. You should adjust 
measurement modules to eliminate 
as much skew as possible so that it 
does not affect the accuracy of your 
 

measurements.

state measurement  In a state 
measurement, the logic analyzer is 
clocked by a signal from the system 
under test. Each time the clock signal 
becomes valid, the analyzer samples 
data from the system under test. 
Since the analyzer is clocked by the 
system, state measurements are 
synchronous with the test system. 

store qualification  Store 
qualification is only available in a 
state measurement, not timing 

measurements. Store qualification 
allows you to specify the type of 
information (all samples, no samples, 
or selected states) to be stored in 
memory. Use store qualification to 
prevent memory from being filled 
with unwanted activity such as no-
ops or wait-loops. To set up store 
qualification, use the While storing 
field in a logic analyzer trigger 
sequence dialog.

subnet mask  A subnet mask blocks 
out part of an IP address so that the 
networking software can determine 
whether the destination host is on a 
local or remote network. It is usually 
represented as decimal numbers 
separated by periods; for example, 
255.255.255.0. Ask your LAN 
administrator if you need a the 
subnet mask for your network.
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symbols  Symbols represent 
patterns and ranges of values found 
on labeled sets of bits. Two kinds of 
symbols are available: 

• Object file symbols - Symbols 
from your source code, and 
symbols generated by your 
compiler. Object file symbols may 
represent global variables, 
functions, labels, and source line 
numbers. 

• User-defined symbols - Symbols 
you create. 

Symbols can be used as pattern and 
range terms for: 

• Searches in the listing display.

• Triggering in logic analyzers and 
in the source correlation trigger 
setup.

• Qualifying data in the filter tool 
and system performance analysis 
tool set. 

system administrator  The system 
administrator is a person who 
manages your system, taking care of 
such tasks as adding peripheral 
devices, adding new users, and doing 
system backup. In general, the 
system administrator is the person 
you go to with questions about 
implementing your software.
28
target system  The system under 
test, which contains the 
microprocessor you are probing.

terms  Terms are variables that can 
be used in trigger sequences. A term 
can be a single value on a label or set 
of labels, any value within a range of 
values on a label or set of labels, or a 
glitch or edge transition on bits 
within a label or set of labels.

TIM  A TIM (Target Interface 
Module) makes connections between 
the cable from the emulation module 
or emulation probe and the cable to 
the debug port on the system under 
test. 

time-correlated  Time correlated 
measurements are measurements 
involving more than one instrument 
in which all instruments have a 
common time or trigger reference.

timer terms  Logic analyzer 
resources that are used to measure 
the time the trigger sequence 
remains within one sequence step, or 
a set of sequence steps. Timers can 
be used to detect when a condition 
lasts too long or not long enough. 
They can be used to measure pulse 
duration, or duration of a wait loop. A 
single timer term can be used to 
delay trigger until a period of time 
after detection of a significant event. 
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timing measurement  In a timing 
measurement, the logic analyzer 
samples data at regular intervals 
according to a clock signal internal to 
the timing analyzer. Since the 
analyzer is clocked by a signal that is 
not related to the system under test, 
timing measurements capture traces 
of electrical activity over time. These 
measurements are asynchronous 
with the test system. 

tool icon  Tool icons that appear in 
the workspace are representations of 
the hardware and software tools 
selected from the toolbox. If they are 
placed directly over a current 
measurement, the tools automatically 
connect to that measurement. If they 
are placed on an open area of the 
main window, you must connect them 
to a measurement using the mouse. 

toolbox  The Toolbox is located on 
the left side of the main window. It is 
used to display the available 
hardware and software tools. As you 
add new tools to your system, their 
icons will appear in the Toolbox.

tools  A tool is a stand-alone piece of 
functionality. A tool can be an 
instrument that acquires data, a 
display for viewing data, or a post-
processing analysis helper. Tools are 
represented as icons in the main 
window of the interface. 
 

trace  See acquisition.

trigger sequence  A trigger 
sequence is a sequence of events that 
you specify. The logic analyzer 
compares this sequence with the 
samples it is collecting to determine 
when to trigger.

trigger specification  A trigger 
specification is a set of conditions 
that must be true before the 
instrument triggers.

trigger  Trigger is an event that 
occurs immediately after the 
instrument recognizes a match 
between the incoming data and the 
trigger specification. Once trigger 
occurs, the instrument completes its 
acquisition, including any store 
qualification that may be specified.

workspace  The workspace is the 
large area under the message bar and 
to the right of the toolbox. The 
workspace is where you place the 
different instrument, display, and 
analysis tools. Once in the workspace, 
the tool icons graphically represent a 
complete picture of the 
measurements.

zooming  In the oscilloscope or 
timing analyzer, to expand and 
contract the waveform along the time 
base by varying the value in the s/Div 
29
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field. This action allows you to select 
specific portions of a particular 
waveform in acquisition memory that 
will be displayed on the screen. You 
can view any portion of the waveform 
record in acquisition memory. 
30
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adding terms, 9
All, 11

C

clear, 12
creating powerful filter 

expressions, 15

D

delete all, 9
delete term, 9
deleting labels, 12
deleting terms, 9

E

example measurements, 6, 7

F

filter expression, 9
filter terms, 9, 10, 11, 12, 13
filtering data out, 6

H

hardcopy, 18

L

labels, adding and deleting, 11, 12
loading and saving filter 

configurations, 17

M

matching states, filtering out, 6
matching states, passing through, 7
measurement examples, 6, 7, 8
Modify Term, 11
modify term, 12
modifying terms, 10, 11, 12, 13
 

N

Not Pattern, 11
Not Range, 11

P

Pass All Data, 8
pass all states, 8
Pass Matching Data, 7
pass through states, 7
passing data through, 7, 8
Pattern, 11
printer, 18
printing windows, configurations, 

18

R

Range, 11
Remove Matching Data, 6
removing data, 6
rename term, 14
replacing labels, 13

T

terms, changing name, 14
terms, filter, 12
turn filter terms off and on, 15

U

using pattern filter, 2

V

value, changing, 10

W

window, printing, 18
workspace, 18
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